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Passes

RenderMan for Maya has a flexible system for the creation of custom passes. Passes can be 
created and deleted. When a pass is selected the settings for that pass will appear. Passes can be 
used to generate shadow maps, environment maps, reference images, occlusion effects, etc. In 
fact, RenderMan for Maya allows the creation of custom passes. Additionally, RenderMan for Maya 
observes Maya's render layers, when enabled (via the check box). See the Maya documentation 
for more information. 

The Passes Tab 
When you first open the 
Passes tab you are 
presented, by default, 
with the outputs for 
your Final pass. You can 
switch to existing passes, create new ones, or apply filters by clicking on the arrow next to the 
Pass window to access a pop-up window. Each pass has a separate tab for Pass Settings and 
Outputs. 

  

The Outputs Sub-Tab 
The default output of the Final 
Pass is, as you might expect, 
rgba, the color and alpha 
channels of a typical image. You 
can select other outputs, 
including �Custom� outputs by 
clicking on the arrow to the 
right of the output window. 

The Outputs Sub-Tab also 
includes settings for the output 
Image Format, Channels, Filter, 
Filter Size, Dither, and 
Exposure. The defaults and 
options for these settings will 
change, depending on the 
output you have selected (e.g. the default image format for rgba is mayaiff, but for _shadow it is 
tiff). For more information on outputs, please see the Outputs section. 

  

 

The Settings Sub-Tab 
The Pass Settings for the Final 
pass are, essentially, pre-
defined, but you can add extra 
settings, such as �Bucket Size�, 
for additional control over the 
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RenderMan Environment Light

Introduction 
Image based lighting and global illumation effects can be created with RenderMan for Maya by 
using the RenderMan Environment Light. You can create an Environment Light any of a number of 
ways: via Maya's Hypershade, via the �Env Light� icon in the RenderMan Shelf, or via the Features 
tab of the Render Settings. Below is a rundown of the User Interface for the RenderMan 
Environment Light, which is accessed via the Attribute Editor. 

The User Interface 
   Environment Image � An 
environment map may be 
added here. If there is no 
environment map, the 
Environment Color will be 
used instead. 
   Environment Color � The 
environment color is set 
here. If there is an 
environment map, that will 
override Environment Color.  
   Intensity � The brightness 
of the environment color or 
image. 
   Emit Specular � Controls 
whether specular (reflective) 
light is projected from the 
light.   
   Emit Diffuse � Controls 
whether diffuse light is 
projected from the light.   
   Primary Visibility � 
Toggles whether the light 
itself appears in renderings.  
   Shadowing � There are 
three shadowing modes: 
none, occlusion, and 
colorbleeding. When set to 
none, no hemispherical 
sampling is calculated. 
When set to occlusion, the 
amount that points are 
covered by geometry is 
calculated with 
hemispherical sampling. 
When set to colorbleeding, 
the color from nearby 
objects will bounce onto 
other objects, the amount of 



which is determined by 
hemispherical sampling. 
Colorbleeding is more accurate, but also much more expensive, than occlusion. 
   Shadow Color Bias � Darkens or lightens the shadow color when shadowing is enabled above. 
   Shadow Color Gain � When shadowing is enabled, this parameter adjusts the contrast of the 
shadow. 
   Sampling Mode � Choose the method to sample the environment map: filtered, sampled, or 
baked. Filtered is �cheapest,� but the least accurate. Sampled is the most accurate, but also the 
most expensive. It is required for image base illumination (IBI). Select Baked to reuse previously 
baked data; this works in conjunction with the Bake parameter.  

   Samples � Specify the number of rays sent into the hemisphere above each point; more 
samples increases the quality of colorbleeding or occlusion, at the cost of increased render times. 
   Max Variation � This is the quality/speed knob. Set this to "10" for quick/low quality renders. 
Set this to "1" or lower for high quality final frames.  
   Diffuse Softness � fraction of the hemisphere above a point that is taken into account for 
ambient occlusion. 
   Max Dist � The maximum distance, in world units, that a ray is shot. This value should be 
lowered for global illumination calculations for interior scenes. 
   Falloff Mode � When falloff is enabled, you can specify the mode by which it is calculated. The 
maxdist-based mode is recommended for interior scenes. This parameter is disabled when the 
Falloff parameter (below) is set to 0 (zero). 
   Falloff � The value of this parameter serves as power by which falloff is calculated. Falloff is 
disabled when this parameter is set to 0 (zero). 
   Subset � A set of objects for inclusion in global illumination calculations can be chosen here 
(right-click for options). 
   Color Correct � Enables color correction. 
   Final Color Saturation � Adjust the intensity of the color. 
   Final Color Bias � When Color Correct is enabled, this parameter lightens or darkens the color. 
   Final Color Gain � This parameter adjusts the contrast when Color Correct is enabled. 
   Bake � Connect a bake node here to compute the effect in a pre-pass for reuse later, or to 
calculate point-based global illumination. There are three baking methods to choose from: 
RenderRadiosity to render point-based global illumination, MakeApproxGlobalDiffuse to bake 
point-based GI data for reuse, and MakeGlobalDiffuse3d to bake ray-traced global illumination 
data for reuse. Additional configuration for the bake pass is done via the Passes Tab of the 
Render Settings.  
   Contribute Radiosity � Enable or disable the radiosity contribution of the Environment Light.  
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Getting Started with The Tools
5.1 Alfred 
5.2 "it" 
5.3 Slim 
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Getting Started with Alfred

About Alfred
Alfred is a work distribution system that manages a hierarchy of parallel client applications 
connected to remote servers. The Alfred components are general purpose but they are especially 
well-suited for managing network-distributed rendering in the context of the RenderMan Studio.  

In operation, Alfred traverses a job script called a worklist, which defines a tree-structured 
hierarchy of dependent tasks. Each task node in the tree contains commands that are executed 
on the local client host, possibly using associated remote servers. Multiple jobs may be queued 
up and performed in succession or in parallel. These terms are defined in more detail elsewhere.  

Using Alfred with RenderMan Studio
Alfred is fundamentally unchanged in RenderMan Studio. It is, however, more tightly integrated 
with Maya. You can still run Alfred in a standalone mode, through the User Interface or via the 
command line, but when you select �RenderMan� as your renderer, you can also access a new 
Alfred window via Maya's Batch Render options. Note that this is a different way to access the 
Alfred options, if you've used the RenderMan Artist Tools; the options are no longer part of the 
Render Globals. 

 

file:///K:/DISE�O%20Y%20PROGRAMACI�N/PIXAR%20RENDERMAN/Renderman%20Studio%201.01%20Server%2013.52/pixar_win32/Docs/RMS_1.0/alfred/dispatching.html#terminology


The RenderMan Batch Render Frame window offers you with a simple interface for controlling 
Alfred's distribution of your renders. To enable Alfred to distribute your batch renders, click the 
Alfred Spool checkbox (if this is unchecked, the Maya batch mechanism is used, even if you are 
using RenderMan as your renderer). 

You can choose the style of distributed render that you wish to use from the dropdown list. The 
options are mayabatch local, mayabatch remote, immediate rib, netrender, deferred rib, remote 
prman, and remote rib, remote prman. Please note that the netrender and remote prman options 
require RenderMan Pro Server installed on your target machines. 

For more detailed information on the ins and out of Alfred, please see the Alfred documentation. 
For more information on RIB and the different methods of ribgen, please see the RfM Pro RIB 
overview. 
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Getting Started with �it�

About �it�

�it� is a robust framebuffer/render view window, offering complete floating point support and a 
powerful and flexible catalog, as well as a fast and powerful imaging tool that is capable of 
production-qualilty image manipulation and compositing usually found only in high-end 
standalone products.

Using �it� with RenderMan Studio

Unlike Alfred, �it� has been completely overhauled, from the ground up, for RenderMan Studio. �it� is 
more powerful, more stable, more useful, and more tightly integrated with Maya. You can still run 
�it� in a standalone mode, through the User Interface or via the command line, or you can select �it� 
as your preview render display from the Render menu. When �RenderMan� is selected as your 
renderer you can select the options menu for Render Current Frame and choose between internal 
renders to Maya's Render View or �it�, as well as external renders (via netrender) to �it�. 

When rendering to �it� through Maya, 
your images are no longer viewed 
through Maya's Render View window; 
a new �it� window is opened. The �it� 
window can be customized by 
selecting view options via the �it� 
menu (right-click in the �it� window to 
access the menu). The status bar 
gives you progress information 
during renders and reports the 
position and rgba values relative to 
your pointer's placement upon your 
render's completion. In addition, 
there is a separate field for notes, 
which can be entered via the 
Common tab of the Render Settings. 

 

 

When using �it� via the Maya UI, right-clicking in the frame window provides the user with a basic 
menu that includes access to the �it� hub. The hub integrates the basic Catalog view with a script 
editor window for loading and executing IceMan scripts. Additionally, starting �it� in standalone 
mode opens the �it� hub. 



 

For more detailed information on the long and short of �it�, please see the �it� documentation.
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Getting Started with Slim

About Slim
Slim is a powerful, extensible tool for creating, manipulating, using, and reusing RenderMan 
shaders, bringing the power of RenderMan shaders into the hands of artists. Users can construct 
RenderMan shaders by interactively combining modules into networks, editing their parameters, 
and previewing the results, all without writing any code. 

Slim can be invoked in two different modes: client (via the Maya UI) or standalone (via the 
command line our your programs/applications menu). Whereas Slim is found on the RenderMan 
menu in the RenderMan Artist Tools, in RenderMan Studio you access Slim via Maya's Window 
menu; go to Window -> Rendering Editors -> RenderMan -> Slim... to open the completely 
redesigned Slim UI. 

 

 

Slim's basic workflow is quite simple: 

1.  From the File menu, choose New Palette to start from scratch, or Open Palette to select 
an existing Slim palette. 

2.  Click on the �+� icon to switch from the Browse to the Create mode. 

3.  Choose an appearance from the Palette View, an icon representing this primary node for 
your Slim network will be displayed in the Network View, and the appearance and its 
parameters will show up in the Appearance View. 

4.  Tweak your appearance as you see fit. Note that by setting parameters to External 
you will be able to continue tweaking after adding the appearance to your Maya 
scene. Click on the swatch to compile the shader. 

5.  To add your Slim appearance to your Maya scene, go to the Appearance menu and select 
Add To Scene. You can then attach the appearance to an object in Maya from Maya's 
Lighting/Shading menu; it has been added to your �existing materials�, so attaching it is 
a matter of selecting your object and choosing if from the Assign Existing Material list. 



For a complete rundown of Slim, please consult the Slim documentation. 
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